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SHORT ABSTRACT: 
DetectSyn is an unbiased, rapid fluorescent assay that measures changes in relative synapse (pre- and postsynaptic engagement) number across treatments or disease states. This technique utilizes a proximity ligation technique that can be used both in cultured neurons and fixed tissue.

LONG ABSTRACT: 
Synapses are the site of communication between neurons. Neuronal circuit strength is related to synaptic density, and the breakdown of synapses is characteristic of disease states like major depressive disorder (MDD) and Alzheimer's disease. Traditional techniques to investigate synapse numbers include genetic expression of fluorescent markers (e.g., green fluorescent protein (GFP)), dyes that fill a neuron (e.g., carbocyanine dye, DiI), and immunofluorescent detection of spine markers (e.g., postsynaptic density 95 (PSD95)). A major caveat to these proxy techniques is that they only identify postsynaptic changes. Yet, a synapse is a connection between a presynaptic terminal and a postsynaptic spine. The gold standard for measuring synapse formation/elimination requires time-consuming electron microscopy or array tomography techniques. These techniques require specialized training and costly equipment. Further, only a limited number of neurons can be assessed and are used to represent changes to an entire brain region. DetectSyn is a rapid fluorescent technique that identifies changes to synapse formation or elimination due to a disease state or drug activity. DetectSyn utilizes a rapid proximity ligation assay to detect juxtaposed pre- and postsynaptic proteins and standard fluorescent microscopy, a technique readily available to most laboratories. Fluorescent detection of the resulting puncta allows for quick and unbiased analysis of experiments. DetectSyn provides more representative results than electron microscopy because larger areas can be analyzed than a limited number of fluorescent neurons. Moreover, DetectSyn works for in vitro cultured neurons and fixed tissue slices. Finally, a method is provided to analyze the data collected from this technique. Overall, DetectSyn offers a procedure for detecting relative changes in synapse density across treatments or disease states and is more accessible than traditional techniques.

INTRODUCTION: 
Synapses are the fundamental unit of communication between neurons1. Many synapses between neurons within the same regions give rise to circuits that mediate behavior2. Synapses consist of a presynaptic terminal from one neuron that releases neurotransmitters or neuropeptides that relay information to postsynaptic receptors of another neuron. The summation of presynaptic signals determines whether the postsynaptic neuron will fire an action potential and propagate the message to other neurons. 

Synaptopathology, the break down of synapses, arises in diseases and disorders marked by decreased neural volume, like Alzheimer's disease and major depressive disorder, resulting in circuits that no longer optimally perform3–5. Restoring synapse density likely underlies the efficacy of potential treatments for these disorders. For example, it was recently demonstrated that increasing synapses underlies the behavioral efficacy of rapid antidepressants6. To rapidly screen possible synaptopathology treatments, researchers require techniques that quickly identify changes to synapse numbers.   

Current methodologies are either time-consuming and expensive (electron microscopy, array tomography), or they only examine postsynaptic changes without incorporating presynaptic engagement (spine analyses, immunofluorescence/colocalization). Dyes like DiI or fluorescent proteins like GFP help visualize neurons and characterize postsynaptic spines. However, spine analysis uses researcher-defined ratios to determine morphology, which can decrease reproducibility7. Further, how the different spine classes relate to functional synapses is still being uncovered8. Spine formation can be transient and may reflect postsynaptic plasticity, but these spines could be eliminated before stabilizing into a synapse with a presynaptic neuron9. 

Colocalization provides a better proxy for synapses than spine analysis because one can immunostain for presynaptic and postsynaptic proteins. However, synaptic proteins may yield low colocalization values because the proteins are juxtaposed and may not consistently overlap. Thus, because the proteins are not wholly superimposed, colocalization techniques may not accurately measure changes to synapse formation due to this missing information. Finally, although both electron microscopy (EM) and array tomography provide high-resolution images of synapses, they are time-consuming. EM further requires specialized equipment, and researchers are limited to small volumes of tissue for any given experiment. While array tomography elegantly provides the ability to screen for many proteins on ultrathin sections and can be combined with EM10, this technique may be too labor-intensive and beyond the scope of experiments that need to scan rapidly for changes to synapse formation.

DetectSyn is a specific application of the Duolink Proximity Ligation Assay. The PLA assay allows for the general detection of protein-protein interactions. DetectSyn bridges proxy postsynaptic measures by amplifying a fluorescent signal emitted by tagged pre- and postsynaptic proteins within 40 nm of each other. If the synaptic proteins are within 40 nm, as within a synaptic cleft, then the secondary antibodies, which contain DNA probes, will hybridize into circular DNA. This hybridized circular DNA expresses a fluorescent probe, which is then amplified and detected with standard fluorescent microscopy techniques (see Figure 1). Crucially, unlike EM and array tomography, this technique does not require specialized equipment and takes about the same amount of time as standard immunohistochemistry. The accessibility of this technique, thus, enables investigators outside of research-intensive institutions to participate in synaptopathology research. Further, this technique can examine changes to synaptic density in multiple brain regions within a single experiment, offering a more holistic representation of synaptic changes due to disease or treatment.  

PROTOCOL: 

Isolation of cells and tissue from animals was in accordance with the National Institutes of Health's Guide for the Care and Use of Laboratory Animals and approved by the Wake Forest Institutional Animal Care and Use Committee

NOTE: This protocol is used on samples already treated and fixed per specific experimental paradigms and requirements. For demonstration purposes, synapse formation due to rapid antidepressant treatment is used to highlight this synapse detection technique6. Neurons previously cultured on coverslips, treated, fixed in 4% paraformaldehyde (PFA), and stored in 1x phosphate-buffered saline (PBS) will be used to highlight the in vitro procedures. Previously sliced hippocampal tissue (25 &#181;m thick) from mice treated, transcardially perfused with ice-cold PBS and 4% PFA, and then stored in cryoprotectant will be used to highlight the slice procedures. Please see11,12 for more information about how to culture neurons or transcardially perfuse rodents. See Figure 1 for a graphical representation of this procedure.

[Place Figure 1 here.]

1.	Rinse samples

1.1.	Rinse the samples with 500 &#181;L of 1x PBS + 0.75% glycine for 5 min 3 times with gentle agitation on an orbital shaker to remove residual PFA or cryoprotectant.

2.	Block and permeabilize samples

2.1.	Prepare blocking and permeabilization solution (10% normal donkey serum, 0.25% Tween 20) in 1x PBS. Prepare enough to use for blocking, primary, and secondary incubations.

2.2.	To samples (e.g., coverslips or free-floating slices) in 24 well plates, add 500 &#181;L of blocking and permeabilization solution. Ensure each well contains a different sample and is appropriately labeled to prevent samples from being switched.

2.3.	Incubate the samples at room temperature (RT) for 60 min for cultured cells or 2 h for sliced tissue. Use an orbital shaker for gentle agitation.

3.	Incubate samples in primary antibodies

3.1.	Prepare primary antibodies in blocking buffer:

3.1.1.	Prepare Postsynaptic density 95 (PSD95; 1:500, rabbit polyclonal), Synapsin1 (1:500, mouse monoclonal), MAP2 (1:400, chicken polyclonal)

3.1.2.	Prepare a negative control aliquot that omits one of the synaptic pairs (e.g., without PSD95)

3.2.	Carefully remove the blocking solution with a plastic Pasteur pipette. Try to remove as much as possible without disturbing the cells or tearing tissue.

3.3.	For cultured cells:

3.3.1.	Line a large plastic petri dish with parafilm. Carefully transfer coverslips to the parafilm using forceps.

3.3.2.	Carefully add 60 &#181;L of the primary antibody solution to the top of the coverslips. Make sure not to spill the primary antibody solution over the side of the coverslip. 

3.3.3.	To provide humidity and prevent samples from drying out during the incubation period, add ultrapure water to a smaller Petri dish and carefully arrange the small Petri dish around the coverslips.

3.3.4.	Cover the large Petri dish and incubate cultured cells for 1 h at RT.

3.4.	For sliced tissue:

3.4.1.	Carefully add 250 &#181;L of the primary antibody solution to free-floating slices in a 24 well plate.

3.4.2.	 Cover the plate and incubate the tissue overnight at 4 &#176;C with gentle agitation on an orbital shaker.

4.	Wash samples, then incubate in secondary antibodies

4.1.	Prepare secondary antibodies in the blocking buffer:

4.1.1.	Prepare Donkey anti-mouse (1:5), donkey anti-rabbit (1:5), donkey anti-chicken (1:400). 

4.1.2.	At this step, additional technical controls can be obtained by preparing a secondary aliquot that omits either the anti-mouse or anti-rabbit secondary.

4.2.	For cultured cells:

4.2.1.	Using forceps, carefully tap off the primary solution from coverslips onto a paper towel

4.2.2.	Using forceps, carefully transfer the coverslips back to their original 24 well plate filled with 500 &#181;L of 1x PBS.

4.3.	For sliced tissue:

4.3.1.	Carefully remove the primary antibody solution with a plastic Pasteur pipette. Try to remove as much as possible without tearing tissue.

4.3.2.	Add 500 &#181;L of 1x PBS 

4.4.	Wash the samples for 10 min 3 times in 1x PBS with gentle agitation on an orbital shaker. During this time, bring all wash buffers to RT.

4.4.1.	During this time, change the parafilm in the large Petri dish

4.5.	For cultured cells:

4.5.1.	Using forceps, carefully transfer the coverslips back to the parafilmed large Petri dish

4.5.2.	Carefully add 40 &#181;L of the secondary antibody solution to the top of the coverslips. Make sure not to spill the secondary antibody solution over the side of the coverslip. 

4.5.3.	If needed, add more ultrapure water to a smaller petri dish and carefully arrange the small petri dish around coverslips.

4.5.4.	Cover the large Petri dish

4.6.	For sliced tissue:

4.6.1.	Carefully add 250 &#181;L of the secondary antibody solution to free-floating slices in a 24 well plate.

4.6.2.	 Cover the plate 

NOTE: From here on, protect samples from light by wrapping the tops of the plates with foil.

4.7.	Incubate the samples at 37 &#176;C for 1 h

5.	Ligation

5.1.	Mix the ligation stock 1:5 in molecular-grade water.

5.2.	As in section 4, carefully transfer the coverslips and remove the secondary mix from the sliced tissue. 

5.3.	Wash the samples in 500 &#181;L of wash buffer A

5.3.1.	For cultured cells, wash 2 times for 5 min. For sliced tissue, wash 2 times for 10 min. Use gentle agitation on an orbital shaker for both.

5.3.2.	During this time, change the parafilm in the large Petri dish

5.4.	While keeping the ligase on a cold block, dilute the ligase 1:40 in the ligation stock from step 5.1. Perform this dilution immediately before adding the ligase to the samples.

5.5.	As in section 4, remove as much of the wash buffer A as possible from samples before adding the ligase. 

5.6.	For cultured cells: Transfer coverslips back to the parafilmed Petri dish. Add 40 &#181;L of the ligation mix to coverslips, arrange small water-filled Petri dishes around the coverslips, and cover the large Petri dish.

5.7.	For sliced tissue: Add 250 &#181;L of the ligation mix from Step 5.4 to each well and cover the plate.

5.8.	Incubate the samples for 30 min at 37 &#176;C.

6.	Amplification

6.1.	Mix the amplification stock 1:5 in molecular-grade water.

6.2.	As in section 4, carefully transfer the coverslips and remove the ligation mix from the sliced tissue. 

6.3.	Wash samples in 500 &#181;L of wash buffer A 

6.3.1.	For cultured cells, wash 2 times for 2 min. For sliced tissue, wash 2 times for 10 min. Use gentle agitation on an orbital shaker for both.

6.3.2.	During this time, change the parafilm in the large Petri dish

6.4.	Perform this dilution immediately before adding the polymerase to samples. While keeping the polymerase on a cold block, dilute polymerase

6.4.1.	For cultured cells, dilute polymerase 1:80 in the amplification stock from step 6.1. 

6.4.2.	For sliced tissue, dilute polymerase 1:40 in the amplification stock from step 6.1. 

6.5.	As in step 4, remove as much of the wash buffer A as possible from samples before adding the polymerase. 

6.6.	For cultured cells: Transfer the coverslips back to the parafilmed Petri dish. Add 40 &#181;L of the amplification mix from Step 6.4.1 to coverslips, arrange small water-filled Petri dishes around the coverslips, and cover the large Petri dish. Incubate the samples for 100 min at 37 &#176;C.

6.7.	For sliced tissue: Add 250 &#181;L of the amplification mix from Step 6.4.2 to each well and cover the plate. Incubate the samples for 2 h at 37 &#176;C. 

NOTE: During this time, prepare and label slides. 

7.	Mounting

7.1.	As in Step 4, carefully transfer the coverslips and remove the amplification mix from the sliced tissue. 

7.2.	Wash the samples in 500 &#181;L of wash buffer B 2 times for 10 min with gentle agitation on an orbital shaker.

7.3.	Wash the samples in 500 &#181;L of 1% wash buffer B for 1 min with gentle agitation on an orbital shaker.

7.4.	For cultured cells:

7.4.1.	Drop 3 &#181;L of mounting media onto a slide

7.4.2.	Tap off excess wash buffer from the coverslip and then place the coverslip (with cells facing down) into the mounting media. Seal the sides with a small amount of clear nail polish to seal the coverslip in place.

7.5.	For sliced tissue:

7.5.1.	Carefully transfer a tissue slice to the prepared slide and arrange it, so the slice is lying flat. Drop between 5–10 &#181;L of mounting media (amount will depend on the size of the slice) onto tissue slice

7.5.2.	Carefully place a glass coverslip over tissue slice and seal with a small amount of clear nail polish along the edge to seal the coverslip in place.

7.6.	Wait at least 15 min before analyzing under the microscope, or store at -20 &#176;C.

8.	Obtain digital images with a confocal microscope.

8.1.1.	Optimize the acquisition settings (e.g., laser power, gain, offset) across samples from all treatments. Ensure that the optimization includes decreasing background noise and enhancing the signal without oversaturating the intensity of the fluorescent signals. Once settings are determined, apply the same acquisition settings across all images obtained. 

NOTE: The following acquisition details can be used with a Nikon A1 confocal microscope and the Nikon NIS AR Elements software. 

8.1.2.	Set the slide with sample on the stage and find the focal plane for the sample using DAPI through the eyepiece. 

8.1.3.	Turn off the eye port by clicking on Eye port and choose an optical configuration button to adjust the settings.

8.1.4.	Adjust the gain, offset, and laser power for each fluorescent channel to decrease background noise and enhance the fluorescent signal. Make sure the fluorescent signal does not become oversaturated as mentioned in steps 8.1.5–8.1.6. 

8.1.5.	Monitor oversaturation using a pseudocolor for the fluorescent signal. At the bottom of the live image, right-click the tab labeled with the fluorescent channel currently being used. 

8.1.6.	Next, choose Channel Coloring and pick a pseudocolor like Rainbow Dark to visualize the fluorescence intensity in a heat-map-like pseudocolor. In Rainbow Dark, cooler colors indicate less fluorescent intensity, and hotter colors indicate more fluorescent intensity. 

8.1.7.	Once all fluorescent channels are optimized, right-click on the optical configuration button previously chosen and choose Assign Current Camera Setting for this button.

8.1.8.	Verify that the chosen settings are sufficient for a random sample from each treatment group. If the chosen settings oversaturate any of these samples, repeat step 8.1.4 to eliminate the oversaturation. 

8.1.9.	For cultured neurons, follow steps 8.1.10–8.1.16.

8.1.10.	Using the eye-port, search for a neuron with dendrites that have minimal overlap with other dendrites.

8.1.11.	Turn off the eye port and use the DAPI channel to visualize the cell body of the chosen neuron. Double-click on the center of the soma to center the neuron in the middle of the field of view.

8.1.12.	 Using the MAP2 channel, find the best plane of focus for the MAP2 signal with live scanning.

8.1.13.	Under the ND Acquisition tab, click on Save to File and choose a file to save the image into under Browse. Then, input the filename. 

8.1.14.	Under the Z tab, select the Symmetric Mode Defined by Range option. Set the focus to the best MAP2 plane and click on the Relative button to set this focal plane as the middle of the z-stack. 

8.1.15.	Set the range to 5 &#181;m with 1 &#181;m steps, and make sure to check Close Active Shutter During Z Movement. Under the Wavelength tab, select the name of the optical button with the previously configured acquisition settings under Optical Conf. Then, click on Run Now. 

8.1.16.	Repeat steps 8.1.10–8.1.15for about 10 neurons per coverslip/treatment.

8.1.17.	For sliced tissue, follow steps 8.1.18–8.1.22 

8.1.18.	Using the eye-port, search for the region of interest. For example, locate CA1 of the hippocampus.

8.1.19.	Turn off the eye-port and use the MAP2 channel to find the best plane of focus for the MAP2 signal with live scanning.

8.1.20.	Under the Acquire menu, choose Scan Large Image. Next, select the optical button's name with the previously configured acquisition settings under the Capturing panel from the panel that opens. Also, ensure to select the correct objective in this panel. 

8.1.21.	Under the Area panel and the eyepiece, use the arrow keys to set the boundaries of the region of interest. Next, click on Save Large Image to File and create a save path filename for the image. 

8.1.22.	Under the Setup panel, make sure Multichannel Capture is checked, and then choose the name of the optical button with the previously configured acquisition settings under Optical Conf.

NOTE: A z-stack for a large image is possible but will increase the scan time.

9.	Analysis

9.1.1.	Similar to acquisition settings, use samples from all treatments to optimize threshold settings. Ensure that the threshold optimization focuses on decreasing background noise and enhancing the signal without oversaturating the intensity of the fluorescent signals. Once these settings are determined, apply the same threshold settings across all images used for analysis as described in steps 9.1.2–9.1.3. 

9.1.2.	In ImageJ, the threshold option is located under the menu Image &gt; Adjust &gt; Threshold. Choose the Dark Background option if the image has a dark background. 

9.1.3.	Next, adjust the upper and lower bounds of the threshold per previously determined optimized threshold settings, then click on Apply. 

9.1.4.	For cultured cells, use the MAP2 channel and a freehand region of interest (ROI) tool to draw an ROI for each neuron, including dendrites and soma. For sliced tissue, draw a freehand ROI within the slice image that encapsulates the area of interest (e.g., stratum radiatum of the CA1 within the hippocampus).

9.1.5.	Obtain the area of the ROI. In ImageJ, measure the area under the menu Analyze &gt; Measure. 

9.1.6.	Detect the number of puncta within each ROI using an automatic detection tool like Particle Analysis in ImageJ following steps 9.1.7–9.1.9. 

9.1.7.	Find the Particle Analysis option under the menu Analyze &gt; Analyze Particles. First, define the puncta size diameter, typically 0.1–3 &#181;m2. 

9.1.8.	Next, choose the Overlay Masks option from the Show drop-down menu and check the Display Results option. Then, click on OK. 

9.1.9.	If puncta are not detected with the diameter range chosen, adjust the range until all puncta are detected with this analysis. Make sure to use the same Particle Analysis settings for all images. 

9.1.10.	Divide the number of puncta by the area of an individual region of interest by following steps 9.1.11–9.1.13.

9.1.11.	Copy and paste the results for each image from the Results pop-up from ImageJ into a spreadsheet. 

9.1.12.	First, identify which file and sample the data were obtained from. Then, divide the area of the ROI by the number of puncta.

9.1.13.	Then, clear the data from the Results pop-up, and repeat steps 9.1.2–9.1.12.

9.1.14.	Normalize results to control samples: Average the results (number of puncta/ROI area) for the control samples. Then, divide the obtained results of all samples by the average of the control to obtain the normalized results. The new average of the control samples should be equal to 1.  

REPRESENTATIVE RESULTS: 
Data modified from Heaney et al.6 are presented to demonstrate an experiment where increased synapse formation is expected (please see  for more information and a more in-depth discussion of the mechanism). Previously, it was demonstrated that rapid antidepressants require activation of the inhibitory metabotropic receptor, GABAB (gamma-aminobutyric acid subtype B), to be effective13. Further, previous data indicated that rapid antidepressants increase postsynaptic markers14; thus, DetectSyn was used to test the hypothesis that rapid antidepressants increase synapse numbers to be effective. 

In cultured neurons, four conditions are tested. First, in the top panel of Figure 2A, cultured neurons were treated with the vehicle under the same conditions as the experimental control. However, the PSD95 primary antibody is omitted to provide a technical control for the DetectSyn assay (see Figure 1 for how each component contributes to the signal). Next, in the Control panel, neurons again are treated with the vehicle but receive both PSD95 and Synapsin1 primaries. Next, cultured neurons are treated only with the rapid antidepressant Ro-25-6981 (Ro) or Ro plus the GABAB agonist, baclofen (Bac). As previously demonstrated13, both the rapid antidepressant Ro-25-6981 and the GABAB agonist baclofen are required for the in vitro efficacy of Ro-25-6981. Thus, an increase in synapse formation is demonstrated by an increase in white puncta (Figure 2A ). Without baclofen, no increase in synapse formation in vitro is seen. 

In vivo, basal GABA levels are sufficient for the rapid antidepressant to work13, so only the rapid antidepressant Ro-25-6981 is administered via intraperitoneal injection to mice (Figure 2B). The left panel of Fig. 2B represents another technical control for the DetectSyn assay. Hippocampal tissue from a saline-treated mouse was probed with both primaries for PSD95 and Synapsin1, but one of the secondaries was omitted. An increase in synapse formation due to treatment with the rapid antidepressant Ro-25-6981 compared to saline-treated mice is demonstrated in the middle and right panels of Figure 2B. 

Representative images for technical controls in vitro and ex vivo are shown. In Figure 2A, one of the primaries for the synaptic pairs is omitted (i.e., PSD95), and in Figure 2B, one of the secondaries is omitted. While some puncta appear in the technical control images, they are generally not the same size, as demonstrated by the white speck in the top panel of Figure 2A compared to the large puncta in the other panels. Further, these puncta are not in the same location as the puncta quantified, as demonstrated by some puncta appearing within the soma of the technical control in Figure 2B. Typically, non-specific puncta occur within the nuclei, perhaps due to the presence of DNA.  

To analyze the representative results in Figure 2A, dendrites (visualized by MAP2 staining and represented here in a grey outline) were traced using a freehand drawing tool to create regions of interest (ROIs). First, the area of the MAP2 ROIs was obtained using the NIS Elements function, ROI Data under the Automated Measurement Results tab. Next, puncta were detected using the Thresholding function in NIS Elements. This function creates a binary mask of objects that fall within a defined intensity threshold. Then, the number of binary objects within the MAP2 ROIs were detected using the NIS Elements function, Binary in ROI, under the Automated Measurement Results tab. The data presented in the graph to the right of Figure 2A are the normalized values of the puncta divided by the area of the ROI.

To analyze the representative results in Figure 2B, the stratum radiatum of the CA1 was traced using a freehand drawing tool to create an ROI. First, the area of the ROI was obtained using the ROI data function, as described in the paragraph above. Next, puncta were detected using the Spot Detection – Bright Spots function, located under the Binary menu. Next, the diameter and contrast values were chosen based on visual inspection of multiple slices from all treatments. Once these values were decided, they were applied uniformly across all analyzed images. The Spot Detection function creates binary masks of objects within the defined diameter and contrast parameters set. Then, the number of binary objects within the MAP2 ROIs were detected using the NIS Elements function, Binary in ROI, under the Automated Measurement Results tab. The data presented in the graph to the right of Figure 2B are the normalized values of the puncta divided by the area of the ROI.

Figure 1: Graphical representation of DetectSyn assay. After permeabilizing cell membranes, primary antibodies for Synapsin1 and PSD95 bind to these synaptic proteins. Secondaries with oligonucleotide tags then bind to the primary antibodies. If Synapsin1 and PSD95 are within 40 nm, as at a synapse, then the oligonucleotides interact, and a fluorescent tag is amplified. This fluorescent signal can then be imaged via standard microscopy and analyzed.

Figure 2: Detection of synapses using DetectSyn assay. White puncta represent synapses detected with DetectSyn PSD95-Synapsin1 proximity ligation assay (yellow arrowheads) in (A) in vitro cultured primary hippocampal neurons and (B) ex vivo CA1 stratum radiatum. In (A), the grey outline represents MAP2 staining. In (A), the top panel labeled PLA control represents samples treated with only vehicle, like the Control. However, the PSD95 primary was not included in the reaction. In the final two panels, neurons were treated with the rapid antidepressant Ro-25-6981 (Ro, 10 &#181;M) or Ro plus the GABAB agonist baclofen (Bac, 50 &#181;M) for 90 min. The increased number of puncta (identified with yellow arrowheads) indicates that in vitro, synapse formation only increases when the rapid antidepressant Ro-25-6981 is administered with the GABAB agonist. In (B), green represents dendrites stained with MAP2, and blue represents nuclei stained with DAPI. Single dendrites, outlined in yellow rectangles in the merged images, are isolated beneath representative images to demonstrate that puncta localize to dendrites. Animals were treated with Ro-25-6981 (10 mg/kg), and tissue was collected 45 min after treatment. The increased number of puncta (identified by yellow arrowheads) indicates that in vivo, the number of synapses increases with basal GABA signaling and the rapid antidepressant Ro-25-6981. Quantification of representative results is represented by the bar graphs and indicates the average number of DetectSyn puncta divided by MAP2 area. Results are normalized to the experimental control. Images were obtained using a Nikon A1plus confocal microscope. Scale bars = (A) 10 &#181;m; (B, top) 50 &#181;m; (B, bottom) 5 &#181;m. Bars represent the mean +/- standard error of the mean. Results analyzed by one-way ANOVA: * p &lt; 0.05, ** p &lt; 0.01, *** p &lt; 0.001, **** p &lt; 0.0001 by post-hoc analysis. The figure has been modified from Heaney et al.6. 

DISCUSSION: 
DetectSyn is a rapid assay that uses a proximity ligation assay to detect proteins within 40 nm of each other, which allows for the detection of synapse formation. This technique improves current fluorescent assays, which serve only as proxy measurements for synapse formation. DetectSyn detects quantifiable changes in synaptic proteins localized within 40 nm, i.e., within the synaptic cleft, of each other. Further, DetectSyn is more cost-effective and takes less time than techniques, like electron microscopy and array tomography, designed to measure synapses and classically designated as gold standard techniques. 

DetectSyn is a highly customizable technique. Any synaptic pair can be used to identify the formation of specific types of synapses, as long as the protein pair reside within 40 nm of each other. While this exciting technique has many applications, one must take care to validate antibodies, including optimal blocking and primary incubation conditions, and continue to support their results using other methods like immunofluorescence. It is suggested to perform these supporting experiments in separate experiments that do not utilize DetectSyn to decrease antibody binding competition (e.g., using goat anti-PSD95 and mouse anti-PSD95 in the same experiment may reduce binding due to competition). Additionally, take care to choose primary antibodies raised in different hosts—for example, goat anti-PSD95 and rabbit anti-Synapsin1. If the same host is used for both primaries, the secondary probes will not discriminate between the two primaries.

Further, because proximity ligation has an amplification step, there is limited information one can draw from the resulting puncta. For instance, different sized puncta are observed (evident in Figure 2B), suggesting a change in synapse size or multiple synapses recruited to the same area. However, even though each sample within an experiment undergoes the same conditions, the amplification step makes it difficult to draw these conclusions categorically.  

Finally, critical steps for this protocol include ensuring the ligase and polymerase remain on an ice block and are added as quickly as possible to samples. Additionally, including technical controls will help identify where non-specific puncta may appear in a given experiment. For example, as seen in Figure 2B, puncta within nuclei are seen in technical controls. Thus, it is crucial to include negative or technical controls to ensure that the signal detected in experimental samples is greater than that seen in these controls. Typically, these technical controls are obtained by omitting one of the primary or secondary pairs. Finally, ensure incubation temperatures are at 37 &#176;C starting at the secondary step.

Importantly, DetectSyn provides an accessible way for almost any laboratory with access to a standard fluorescent microscope, regardless of technical experience, to study synaptopathologies. 
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